Precedents Drafting Aide

Download and Install Drafting Aide @z

Thomson Reuters Precedents have a document automation feature called the Precedents Drafting Aide (the
Drafting Aide). The Drafting Aide is a Microsoft Word (MS Word) Macro which has been specially created to help

you draft and fill in form documents with speed and efficiency.

You only install the Drafting Aide once on your computer and it is available to you every time you use MS Word.
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Using the Drafting Aide — Trouble-shooting

Downloading the Drafting Aide

The first step in installing the Drafting Aide is to download the installation file.

The instructions for downloading the Drafting Aide are different depending on which Thomson Reuters product you
are using to access Thomson Reuters Precedents. To view the instructions for your product, click on the applicable

link below:

Westlaw NZ

Checkpoint

CD-Rom

Westlaw
Precedents Drafting Aide — Download instructions

1. Close any email applications you have open (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).




Go to any Precedent in Westlaw NZ and click on the Drafting Aide tab:
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Click on the link Download and Install Drafting Aide:
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Save the Drafting Aide installation file (Brkprcd4.doc)

Please follow the instructions for the web browser you are using:

Internet Explorer 11 Chrome Firefox




Internet Explorer 11

After you click on the link Download and Install Drafting Aide, a dialog box will appear at the bottom of

the webpage. You will be prompted:

Do you want to open or save Brkprcd4.doc from westlaw.co.nz?

Do you want to open or save Brkprcd4.doc from westlaw.co.nz? Open Save | ¥ Cancel

Click Save.

By default, the file will save to the Downloads folder. If you click on the dropdown menu next to Save you

will have the option to Save as, to save the file to another location of your choice.
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After saving you will get a message:

The Brkprcd4.doc download has completed.

cd  The Brkpredd.doc download has completed, Open d Open folder View downloads

You will be given the option to Open, Open folder or View downloads. If you wish to install the Drafting
Aide now, click on Open to open the Drafting Aide installation file in MS Word. (Alternatively, you may
click Open folder or View downloads to find the file Brkprcd4.doc where you saved it on your computer or

network).

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using

(click on the applicable link below):

MS Word 2016 MS Word 2007 MS Word 2000

MS Word 2013 MS Word 2003 MS Word 97

MS Word 2010

Return to top




Chrome

After you click on the link Download and Install Drafting Aide, a link to the file Brkprcd.doc will display on

the bottom left corner of the webpage. By default, the file will download to the Downloads folder on your

computer.
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If you wish to install the Drafting Aide now, click on Brkprcd4.doc in the bottom left corner to open MS
Word and start the installation of the Drafting Aide (or click on Show all downloads in the bottom right

corner to find the file Brkprcd4.doc in the Downloads folder).

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using

(click on the applicable link below):

MS Word 2016 MS Word 2007 MS Word 2000
MS Word 2013 MS Word 2003 MS Word 97

MS Word 2010

Return to top




Firefox

After you click on the link Download and Install Drafting Aide, a dialog box will appear: Opening

BrkprcO4.doc. Select Save File and click OK.

Opening Brkpredd.doc @
You have chosen to open:
] Brikpredd.doc
which is: Microsoft Office Word 97 - 2003 Document

from: http://www.westlaw.co.nz

What should Firefox do with this file?

Microsoft Office Word (default) A

) SaveFile

[ Do this automatically for files like this from now on.

| ok || concel |

By default, the file will save to your Downloads folder.

After clicking Save File, click on the Downloads icon (the downward arrow) in the top right corner of the

Firefox window:
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Click on Brkprcd4.doc to open MS Word and start installation of the Drafting Aide (or, click on Show All

Downloads to find Brkprcd4.doc in the Downloads folder).

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using

(click on the applicable link below):

MS Word 2016 MS Word 2007 MS Word 2000

MS Word 2013 MS Word 2003 MS Word 97

MS Word 2010

Return to top




Checkpoint

Precedents Drafting Aide — Download instructions

3.

Close any email applications you have open (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).

Go to any Precedent in Checkpoint and click on Drafting Aide in the left sidebar menu:
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4. Click on the link Download and Install Drafting Aide (in orange text):
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5. Save the Drafting Aide installation file (Brkprcd4.doc)

Please follow the instructions for the web browser you are using:

Internet Explorer 11 Chrome_Checkpoint Firefox_checkpoint

Internet Explorer 11

(Instructions are as for Westlaw NZ)




Chrome

After you click on the link Download and Install Drafting Aide, a link to the file Brkprcd.doc will display on

the bottom left corner of the webpage. By default, the file will download to the Downloads folder.
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Click on Brkprcd4.doc in the bottom left corner to open MS Word and start installation of the Drafting Aide
(or click on Show all downloads in the bottom right corner to find the file Brkprcd4.doc in the Downloads

folder).

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using

(click on the applicable link below):
MS Word 2016 MS Word 2007 MS Word 2000
MS Word 2013 MS Word 2003 MS Word 97

MS Word 2010

Return to top




Firefox

After you click on the link Download and Install Drafting Aide, a dialog box will appear: Opening

BrkprcO4.doc. Select Save File and click OK.

Opening Brkprcdd.doc @
You have chosen to open:
] Brkprcd4.doc
which is: Microsoft Office Word 97 - 2003 Document

from: http://www.checkpointau.com.au

What should Firefox do with this file?

") Openwith | Microsoft Office Word (default) -

@) Save File

[T] Do this autoratically for files like this from now on.

| ok || concel |

By default, the file will save to your Downloads folder.

After clicking OK, click on the Downloads icon (the downward arrow) in the top right corner of the Firefox

window:

jocumentZendChunk=18bcguid= AUNZ TOC|[54ba58 7 093 eedSi2cB2cf02014 358 Bidocguid=[14 21 db90480e11 el Beefabd HI0088 ¢ || Q Seorch Sl =] 4 ) [ -]
Law Styl... I] NZ Herald: New Zeala.. S The Dominion Post- ... @8 New Zealand Statutes ... % Welcome to the Replic... e- Radio New Zeal 4 Editorial

|
Brikpredd.doc
368 KB — checkpointaw.com.au — 1:40 P
_ QEIRORN Dakbioh Iy h

Precedents Drafting Aide

Tips for Searching

Click on Brkprcd4.doc to open MS Word and start installation of the Drafting Aide (or, click on Show All

Downloads to find Brkprcd4.doc in the Downloads folder).

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using

(click on the applicable link below):

MS Word 2016 MS Word 2007 MS Word 2000
MS Word 2013 MS Word 2003 MS Word 97

MS Word 2010

Return to top

10



CD-Rom

Precedents Drafting Aide — Download instructions

1. Close any email applications you have open (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).

2. Open a Thomson Reuters Precedents product and click on “Install Drafting Aide”
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Precedents Drafting Aide

When you click on Install Drafting Aide, MS Word will open.

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using

(click on the applicable link below):

MS Word 2016 MS Word 2007 MS Word 2000

MS Word 2013 MS Word 2003 MS Word 97

MS Word 2010

Return to top
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Installing the Drafting Aide into MS Word

Once you have downloaded the Drafting Aide onto your computer (from Westlaw NZ, Checkpoint, or from CD-

Rom), the final step is to install (or finish installing) the Drafting Aide into MS Word.

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using (click on the

applicable link below):
MS Word 2016 MS Word 2007 MS Word 2000
MS Word 2013 MS Word 2003 MS Word 97

MS Word 2010

Return to top

MS Word 2016

1. Ensure any email applications on your computer are closed (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).
2. Open the Precedents Drafting Aide installation file Brkprc4.doc (if not already open)

If you have just followed the instructions for downloading the Drafting Aide, the installation file

(Brkprc4.doc) should already be open in MS Word.

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find
Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if it was saved elsewhere).

Once you have found the file Brkprc4.doc, double click on it to open it in MS Word.
3. Enable Content to allow the Drafting Aide to install
When Brkprcd4.doc opens in MS Word 2016 you may see a security warning as below:

SECURITY WARNING Macros have been disabled. [Enable Content

Bricprodd | Compatibiity Mode] - Word
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Click on Enable Content to allow the Drafting Aide to install.

Click OK to copy Brkprcd.dot to the Microsoft Word startup path

After clicking Enable Content the following dialog box will appear:

Precedents Drafting Aide v4.02 x

Cancel

BREPRCD.DOT will be copied to Microsoft Word startup path:

Click OK to copy Brkprcd.dot to the Microsoft Word startup path.

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time
you use MS Word).

Click OK and restart MS Word to confirm the Drafting Aide has been installed

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box

below:

Precedents Drafting Aide *

Installation complete. Close Word and the Precedents Drafting Aide
will be available next time Word is started.

Click OK and re-start MS Word (if it does not re-start automatically).

After restarting MS Word, click on the Add-ins tab to confirm that the Precedents Drafting Aide

has been installed successfully:
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If the Drafting Aide has been successfully installed, you should see the Drafting Aide icon under the Add-
ins Tab.

&

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below.

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go
to Downloading and opening a Precedent below.

Trouble-shooting

If you encountered any problems installing the Drafting Aide:

Check the Installation Trouble-shooting guide

OR

Contact our Techcare team for assistance:

Phone 0800 10 60 25 or

Email TechCare.ANZ@thomsonreuters.com

Return to top

MS Word 2013

Ensure any email applications on your computer are closed (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).
Open the Precedents Drafting Aide installation file (if not already open)

If you have just followed the instructions for downloading the Drafting Aide, the installation file

(Brkprc4.doc) should already be open in MS Word.
If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.

(By default, Brkprc4.doc will be in the Downloads folder on your computer).

14
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4.

Enable Content to allow the Drafting Aide to install
When MS Word 2013 opens, you may get a security warning:

SECURITY WARNING Macros have been disabled. [Enable Content

E‘ H *?' ¥ Bripredd |Compatibility Mode
FILE HOME INSERT DESIGM PAGE LayouT REFEREMCES MAILINGS REVIEW VIEW ADD-INS
TimesMNewRo =10 ~-|A A Aa- f S-i=-%- &= 8 0 AaBbCcDe | A

Paste U « L x akr viEEEE= . Mol T Marmal | 11
¥ Format Painter 54 o e = :

Clipboard ] Font [ Paragraph
I SECURITY WARNING Macraos have been disabled. Enable Content
Navigation Rt
Search decument D -

HEADINGS PAGES RESULTS

Create an interactive outline of yout Precedents Drafting Aide
document.

If so, click Enable Content to allow the Drafting Aide to install.

Copy Brkprcd.dot to the Microsoft Word startup path

After clicking Enable Content the following dialog box will appear:

Precedents Drafting Aide v4.02 X

Cancel

BREPRCD.DOT will be copied to Microsoft Word startup path:

Click OK to copy Brkprcd.dot to the Microsoft Word startup path.

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time
you use MS Word).

Click OK to complete installation and restart MS Word 2013

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box

below:

Precedents Drafting Aide x

Installation complete, Close Word and the Precedents Drafting Aide
will be available next tirne Word is started.
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Click OK and re-start MS Word (if it does not re-start automatically).

6. Restart MS Word 2013 to confirm the Drafting Aide has been successfully installed

Go to the ADD-INS tab and look for the Drafting Aide icon as below:

‘ot - Weard

IMNSERT DESIGH PAGE LAYOUT REFEREMCES FAAILIMGS REWVIEW WIEW ADD- IS

Mawvigation -
The Drafting Aide icon looks like this:
If the Drafting Aide icon is in the ADD-INS tab then the installation was successful.

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below.

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go

to Downloading and opening a Precedent below.

Trouble-shooting

If you encountered any problems installing the Drafting Aide,

check the Installation Trouble-shooting guide

OR

contact our Techcare team for assistance:

Phone 0800 10 60 25 or

Email TechCare.ANZ@thomsonreuters.com

Return to top

MS Word 2010
1. Ensure any email applications on your computer are closed (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).
2. Open the Precedents Drafting Aide installation file (if not already open)

If you have just followed the instructions for downloading the Drafting Aide, the installation file

(Brkprc4.doc) should already be open in MS Word.

16
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If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.
(By default, Brkprc4.doc will be in the Downloads folder on your computer).
Enable Editing to allow the Drafting Aide to install

When MS Word 2010 opens, you may get a security warning:

Protected View This file originated from an internet location and might be unsafe. Click for more details. [Enable editing

A @ | = Brkprcd4 (1) (Protected View) - Microsoft Word
Outlining Home Insert Page Layout References Mailings Review View Add-Ins FDF
0 Protected View  This file originated from an Internet location and might be unsafe, Click for more details. Enable Editing

@  Precedents Drafting Aide

If so, click Enable Content to allow the Drafting Aide to install.

Click OK to copy Brkprcd.dot to the Microsoft Word startup path

After clicking Enable Content the following dialog box will appear:

Precedents Drafting Aide v4.02 X

Cancel

BREPRCD.DOT will be copied to Microsoft Word startup path:

Click OK to copy Brkprcd.dot to the Microsoft Word startup path.

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time
you use MS Word).

Click OK to complete installation and restart MS Word 2010

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box

below:

Precedents Drafting Aide x

Installation complete, Close Word and the Precedents Drafting Aide
will be available next tirne Word is started.

Click OK and re-start MS Word (if it does not re-start automatically).
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6. Restart MS Word 2010 to confirm the Drafting Aide has been successfully installed

Once MS Word 2010 has re-started, go to the Add-ins tab and look for the Drafting Aide icon as below:

@ (=] J @ = |+ Document] - Microsoft Word
Hame Insert Page Layout References Mailings Review View Add-Ins PDF

‘ Convert to PDF |

Menu Commands | Toolbar Commands| Custom Toolbars

L

The Drafting Aide icon looks like this:

If the Drafting Aide icon is in the Add-ins tab then the installation was successful.

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below.

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go

to Downloading and opening a Precedent below.

Trouble-shooting

If you encountered any problems installing the Drafting Aide,

check the Installation Trouble-shooting guide
OR

contact our Techcare team for assistance:

Phone 0800 10 60 25 or

Email TechCare.ANZ@thomsonreuters.com

Return to top

MS Word 2007

1. Ensure any email applications on your computer are closed (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).
2. Open the Precedents Drafting Aide installation file (if not already open)

If you have just followed the instructions for downloading the Drafting Aide, the installation file

(Brkprc4.doc) should already be open in MS Word.

If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.
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4.

(By default, Brkprc4.doc will be in the Downloads folder on your computer).
Enable the content to allow the Drafting Aide to install
When MS Word 2007 opens, you may get a security warning:

SECURITY WARNING Macros have been disabled.

T T &J __]E = Brkprcd4.doc

Cutlining Home Insert Page Layout References Mailings Review WView Add-Ins

|| B Show Level: Al Level - L ;
1| [wa | Body Text - | [ [ 2R L M il =] - %
I V| Show Text Formatting o o

| A e e Show

- Close
Show First Line Only Dacument Subdae

1ent Cutline View
Qutline Tools Master Document Close

@ Security Warning Macros have been disabled. Qptions...

@  Precedents Drafting AideT

If so, click Options.

The following dialog box will open:

Microsoft Office Security Options @I

@ Security Alert - Macro

Macro

Macros have been disabled, Macros might contain viruses or other security hazards, Do
not enable this content unless you trust the source of this file,

Warning: It is not possible to determine that this content came from a
trustworthy source. You should leave this content disabled unless the
content provides critical functionality and you trust its source.

More information

File Path: C:\Jsers\u0106699'Downloads \Brkprod4.doc

@ Help protect me from unknown content (recommended)

") Enable this content

Open the Trust Center E L 0K ] ’ Cancel

Select Enable this content and click OK.
Click OK to Copy Brkprcd.dot to the Microsoft Word startup path

After clicking OK to Enable Content the following dialog box will appear:

Precedents Drafting Aide v4.02 X

BREPRCD.DOT will be copied to Microsoft Word startup path:

Cancel
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Click OK to copy Brkprcd.dot to the Microsoft Word startup path.

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time

you use MS Word).

Click OK to complete installation and restart MS Word 2007

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box

below:

Precedents Drafting Aide *

Installation complete. Close Word and the Precedents Drafting Aide
will be available next time Word is started.

Click OK and restart MS Word (if it does not restart automatically).

Restart MS Word 2007 to confirm the Drafting Aide has been successfully installed

Go to the Add-ins tab and look for the Drafting Aide icon as below:

EE;: = ) @L_:f J ‘; ¥ Document2 [

i
-—/ Home Insert Page Layout References Mailings Review View Add-Ins

&

Custom Toolbars

[L]] | Precedents Dratting Aide : Precedents Drafting Aide i )

The Drafting Aide icon looks like this:

If the Drafting Aide icon is in the Add-ins tab then the installation was successful.

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below.

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go

to Downloading and opening a Precedent below.
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Trouble-shooting

If you encountered any problems installing the Drafting Aide:

Check the Installation Trouble-shooting guide

OR

Contact our Techcare team for assistance:

Phone 0800 10 60 25 or

Email TechCare.ANZ@thomsonreuters.com

Return to top

MS Word 2003

Ensure any email applications on your computer are closed (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).
Open the Precedents Drafting Aide installation file (if not already open)

If you have just followed the instructions for downloading the Drafting Aide, the installation file

(Brkprc4.doc) should already be open in MS Word.

If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.
(By default, Brkprc4.doc will be in the Downloads folder on your computer).

Click Enable Content to allow the Drafting Aide to install

When MS Word 2003 opens, you may get a security warning:

| Sec TR LY Y T ) -

"CDocuments and Settingsiu007501 3 DeskioptBrkprodd, doc” contains
Macros.

Macros may conkain viruses, It is usually safe ko disable macros, but if the
macros are legitimate, wou might lose some Functionality,

[ Disable Macros ] [ Enable Macros ] [ More Info

If so, click Enable Macros to allow the Drafting Aide to install.
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4. Click OK to copy Brkprcd.dot to the Microsoft Word startup path

After clicking Enable Macros the following dialog box will appear:

Precedents Drafting Aide v4.02 >

BREPRCD.DOT will be copied to Microsoft Word startup path:

Cancel

Click OK to copy Brkprcd.dot to the Microsoft Word startup path.

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time
you use MS Word).

5. Click OK to complete installation and restart MS Word 2003

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box

below:

Precedents Drafting Aide >

Installaticn complete. Close Word and the Precedents Drafting Aide
will be available next time Word is started.

Click OK and restart MS Word (if it does not restart automatically).
6. Restart MS Word 2003 to confirm the Drafting Aide has been successfully installed

Check for the Drafting Aide icon in the Toolbar:

&

If the Drafting Aide icon is on the Toolbar, then the Drafting Aide has been installed successfully.

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below.

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go

to Downloading and opening a Precedent below.
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Trouble-shooting

If you encountered any problems installing the Drafting Aide:

Check the Installation Trouble-shooting guide

OR

Contact our Techcare team for assistance:

Phone 0800 10 60 25 or

Email TechCare.ANZ@thomsonreuters.com

Return to top

MS Word 2000
1. Ensure any email applications on your computer are closed (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).
2. Open the Precedents Drafting Aide installation file (if not already open)

If you have just followed the instructions for downloading the Drafting Aide, the installation file

(Brkprc4.doc) should already be open in MS Word.
If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.
(By default, Brkprc4.doc will be in the Downloads folder on your computer).

3. Completing installation

When MS Word 2000 opens, you will see the words Precedents Drafting Aide.

B G pe e Fpms fod Mgl e des
Ned &L 7 [ - LAHOEm 4 By v« §, o b - 10+ B S B ERENESEEEOF-§5 .
-
fn.l-qu---"'n_; i F . 1 ' ' ' ' = n = ) i TR T =
.H
| Frecedenls Diraltling Asde

You may need to change the security settings to allow the Drafting Aide to install.

Click on the Tools menu at the top of the page, then on Macro and finally Security:
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When you click on Security, the Security dialog box will open:

Security

Trusted Sources

" High. Qnly signed macros from trusted sources will be
allowed ta run. Unsigned macros are autonmatically
disabled.

™ Medium. You can choose whether or not to run
patentially unsafe macros,

(* Low (not recommended). You are not protected From
potentially unsafe macros, Use this setting only if vou
hawe wvirus scanning software installed, or vou are sure
all dacuments vou open are safe.

Mo virus scanner installed,

(a4 | Cancel

Select Low so you are able to install the Drafting Aide and then click OK.

Click OK to copy Brkprcd.dot to the Microsoft Word startup path

After clicking OK the following dialog box will appear:

Precedents Drafting Aide v4.02 X
BREPRCD.DOT will be copied to Microsoft Word startup path:
0K
Cancel

Click OK to copy Brkprcd.dot to the Microsoft Word startup path.
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(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time
you use MS Word).

Click OK to complete installation and restart MS Word 2000

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box

below:

Precedents Drafting Aide x

Installation complete, Close Word and the Precedents Drafting Aide
will be available next tirne Word is started.

Click OK and restart MS Word (if it does not restart automatically).
Restart MS Word 2000 to confirm the Drafting Aide has been successfully installed

Look for the Drafting Aide icon, as below, in the toolbar:

If the Drafting Aide icon is in the toolbar, then the installation was successful.

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below.

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go

to Downloading and opening a Precedent below.

Trouble-shooting

If you encountered any problems installing the Drafting Aide:

Check the Installation Trouble-shooting guide

OR

Contact our Techcare team for assistance:

Phone 0800 10 60 25 or

Email TechCare.ANZ@thomsonreuters.com

Return to top
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MS Word 97

1. Ensure any email applications on your computer are closed (eg Outlook)

(Please note: having email applications open during installation may prevent the Drafting Aide from

installing properly).
2. Open the Precedents Drafting Aide installation file (if not already open)

If you have just followed the instructions for downloading the Drafting Aide, the installation file

(Brkprc4.doc) should already be open in MS Word.
If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.
(By default, Brkprc4.doc will be in the Downloads folder on your computer).

3. Complete installation

When MS Word 97 opens, you may get a security warning as you are about to install an MS Word Macro:

Warning

The document you are apening conkains macros or customizations, Some macros may
contain wiruses that could harm wour computer,

If vwau are sure this dacument is From a trusted source, click
Enable Macros, IF wou are nok sure and want to prevent any Tell Me Mare |
macraos From running, click Disable Macros.

[v Always ask before opening documents with macros or cuskomizations

Enable Macros Do Mot Open |

Please click Enable Macros (if you click Disable Macros the Drafting Aide will not install).

4. Click OK to copy Brkprcd.dot to the Microsoft Word startup path

After clicking Enable Content the following dialog box will appear:

Precedents Drafting Aide v4.02 ped

BREPRCD.DOT will be copied to Microsoft Word startup path:

Cancel

Click OK to copy Brkprcd.dot to the Microsoft Word startup path.

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time
you use MS Word).
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5.

Click OK to complete installation and restart MS Word 97

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you will see the dialog box

below:

Precedents Drafting Aide *

Installation complete. Close Word and the Precedents Drafting Aide
will be available next time Word is started.

Click OK and restart MS Word (if it does not restart automatically).
Restart MS Word 97 to confirm the Drafting Aide has been successfully installed

Check for the Drafting Aide icon as below in the Toolbar:

If the Drafting Aide icon is in the Toolbar then the installation was successful.

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below.

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go

to Downloading and opening a Precedent below.

Trouble-shooting

If you encountered any problems installing the Drafting Aide:

Check the Installation Trouble-shooting guide
OR

Contact our Techcare team for assistance:

Phone 0800 10 60 25 or

Email TechCare.ANZ@thomsonreuters.com

Return to top
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Installation Trouble-shooting

For help with trouble-shooting, please contact our

Techcare service

Phone 0800 10 60 25 or

Email TechCare.ANZ@thomsonreuters.com

1. | got to the end of the installation process, but when | restarted MS Word, the Drafting
Aide icon was not in the Add-ins tab (or in the Toolbar if using MS Word 2003 or below)

To fix this problem, follow the instructions for your version of MS Word:

MS Word 2016 and 2013 MS Word 2010 MS Word 2007 MS Word 2003

MS Word 2016 and 2013

1. Click on the File tab

2. Click on Options

3 Compatibility Mode
ﬂ ] Some new features are disabled to
prevent problems when working with

Convert
o previous versions of Office.
Converting this file will enable these
features, but may result in layout
changes.
Protect Document
,’ Control what types of changes people
Protect can make to this document.
Document =
Inspect Document
L =] Before publishing this file, be aware
Account Check for | that it contains:
Issues = Document properties and
Feedback author's name
Manage Document
O\ Check out document of recovier
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3.

5.

Click on Add-ins, then select Word Add-ins from the drop-down menu at the bottom of the

window and click Go

ActionsPane Schema for Add-Ins ch
Custom XML Data H
Headers, Footers, and Watermarks
Hidden Text

Invisible Content

Microsoft Actions Pane 3
OneNote Motes about Word Documents Ch.
Time (XML} Ch.

Trust Center

Document Related Add-ins

No

nt -ins

o

Disabled Application Add-ins

rosoft Shared\WSTOVActionsPane3.xsd
Jdcrosoft Office\Office1M\OFFRHD.DLL

icrosoft Office\Office 14\OFFRHD.DLL

Muoicrosoft Office\Office 14\OFFRHD.DLL
.wicrosoft Office\Office 1OFFRHD.DLL

oft Office\Office1NONWordAddin.dll
Microsoft Shared\Smart Tag\MOFL.DLL

| Word Options 7
General =) h ) )
gy View and manage Microsoft Office Add-ins.
Display
Procfing Add-ins
Save Mame « Location Type ~
Language Active Application Add-ins
brkpred.dot oMicrosoft\Word\STARTUP\brkpred.dot  Template
Advanced Financial Symbaol (XML Microsoft Shared\Smart Tag\MOFL.DLL  Action
Instant Messaging Contacts (English) .oft Shared\Smart Tag\IMCONTACT.DLL ~ Action
Customize Ribbon Measurement Converter (Measurement Convertar) ...050ft Shared\Smart Tag\METCONV.DLL  Action
PDFComplete ..Files x26)\PDF Complete\officepdf.dll  COM Add-in
Quick Access Toolbar
Inactive Application Add-ins

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
COM Add-in

Action

Word Add-ins

No D dd-ins N
Add-i brkpred.dot
Publisher:
Compatibility: Mo compatibility information available
Location: ChUsers\imogentAppData\Roaming\Microsoft\Word\STARTUP\brkpred.dot
Description:
Manage: | COM Add-ins v Go.
COM Add-ins

Templates

XML Schemas

XML Expansion Packs
Disabled Iltems

Check in the list of Global templates and add-ins for the file name brkprcd.dot:

Templates and Add-ins

Templates XML Schema XML Expansion Packs  Linked C55

Document template
Mormal

|:| Automatically update document styles
Attach to all new e-mail messages

Global templates and add-ins

Checked items are currently loaded.

Attach...

Add...

Remave

Full path:  C\...\Roaming'\Microsoft\Word\STARTUP\brkprcd.dot

Qrganizer..,

Cancel
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If the checkbox next to the file name brkprcd.dot is not ticked, tick it and click OK.

(NB: If the checkbox is not ticked, this cause either:
. the Add-ins tab to not appear; OR

. the Drafting Aide icon not to appear in the Add ins tab)

Restart MS Word

After you restart MS Word:

e The Add-ins tab should appear if it was not there before

e  The Drafting Aide icon should appear in the Add-ins tab

Return to top

MS Word 2010

1.

2.

3.

Click on the File tab

Click on Options

LR g Docurment] - Microsoft Word

Home Insert Page Layout References Mailings Review View Add-Ins

lg Save
Support

Save As g
e Microsoft Office Help L”nx
- @

Get help using Microsoft Office.

[ Close
. _— Getting Started Product Activate
oo LO‘ See what's new and find resources to help Microsoft Office Pi
you learn the basics quickly. This product contai
Recent Microsoft OnelMote,
Contact Us Microsoft Word, Mi
New Let us know if you need help or how we can
make Office better,
About Microsoft
Print Tools for Working With Office

Version: 14.0.7177.5(

Save & Send Options Additional Version &
= Customize language, display, and other Part of Microsoft Of
program settings. © 2010 Microsoft C

Microsoft Custormne

O;-iEEE atest updates availlable for MICrosol Microsoft Software

9 et

Follow instructions 3—6 as for MS Word 2016 and 2013 above
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MS Word 2007

1. Click on the File tab
2. Click on Word Options
& i VRGN
Rrview
. Recent Docusments
Prew I:: =
1 Drating Aice_lnstalabion Inclredicn:_Westls i £
7 Qpen 2 Master chieckint. doc - 'E E & |
3 Thompion Reuters Ovensew of Ressurce Men.,, = |
i= Cokany 4 Drating Alde nrialisbion bnrisenicns Chackp... !
JJ 5 Bekprood doc = I :
& DOrating Aide_lnstalsbion Dnctrudicns_Westls... .
H e
1 o 1 Drating Alde_Installation Instrudions_Chedkp.. -
= B installing the drafting side in Ma'Word 3007 2.
h‘& S b 0 Dvating Alde_Bitamation DArtasdtichs Wieitis.

Deating Alde_lnstalation barieudtions Weitla

fam |
| Erint k Dieating Aide_instaliation Instrsdions_Checkp.

o Drafting Aide 2016 Reveewrt! -~
P Prepare » Statutory_Form (2).coc

Statutoey_Foem (1).do¢
E.a- Send ¢ bakpecddot
Beatiard.en.dodn -

5 Publish # Exkpecdd 1).doc =

ose

) Woed Optjons

3. Follow instructions 3—6 as for MS Word 2016 and 2013 above

MS Word 2003

1. Click on the Tools tab

2. Click on Templates and Add-ins in the Tools menu

3. Follow instructions 3-5 as for MS Word 2016 and 2013 above

4. Once you have followed these instructions, the Drafting Aide icon should appear in the Toolbar

| got to the end of the installation process, but when | restarted MS Word, there was no
Add-ins tab (MS Word 2007 and above)

Follow the instructions as for problem 1 above.

When | try to install the Drafting Aide, MS Word hangs/freezes

The Drafting Aide has been tested and successfully installed in all versions of MS Word from MS Word 97

through to MS Word 2016.

If MS Word freezes or hangs during installation, it is possible there is something in your own IT

environment that is preventing the Drafting Aide from installing successfully.
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You may contact Techcare (0800 10 60 25 or email TechCare.ANZ@thomsonreuters.com ) or, your own

IT support (if you have any) if you need help to trouble-shoot such problems. (Support is also available

directly from Microsoft; see https://support.office.com/).

Some things an IT support person should check would be:
e Was there an email application that was open when the Drafting Aide was being installed?

e Are the latest MS Word updates installed (there may be an issue that has been resolved in a

recent update)?

e Are there incompatible Add-ins installed in the copy of MS Word you are using (if so, it may be

necessary to disable these before installing the Drafting Aide)?

e Are there security settings set up by your IT systems administrator (eg which block you from

installing a macro) that might be preventing the Drafting Aide from installing?

e Are there any other software/operating system conflicts causing MS Word to freeze/hang (check
if any other new software has been installed recently that might be causing conflicts, or; check

Microsoft support forums for any known conflicts: https://support.office.com/)?

Return to top

4, Can linstall the Drafting Aide on an Apple computer?

While Thomson Reuters Precedents are not compatible with Apple computers, if the user is running
Windows emulation software, both the Precedents and the Precedents Drafting Aide should run as normal

inside the emulated Windows environment.

Return to top

Downloading and opening a Precedent

Please follow the instructions for the Thomson Reuters product you are using:

Westlaw NZ Checkpoint CD-Rom

Westlaw NZ

To download a Precedent, click on the Word document icon:

next to the Precedent Type:
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THOWB0H RTUTEAR

| WESTLAW

* WORKFLOW

AL

L

NEWSRDOM

& yhers B WyFolders 88 MyConsaos @

Document Options b fetum to orfginal results

FishPrc02 — Agreement for sale and purchase of Annual Catch

Document in

A Forms & Precedents | Dirafiting Aide Variable Information Cited Documents
T:u i Precedent Type: Precedent
¥ Bood Jurisdiction; Bew Zealand
* Nw Ted Last Reviewed: ¢ 2015
¥ Fishories
Precedents

FishPrc02 — Agreement for sale and purchase of Annual Catel

i 2 i : -
Nobes o the precedent

Please continue to the instructions for the web browser you are using:

Chrome Firefox

Internet Explorer 11

Internet Explorer 11

After you click on the Word icon, a dialog box will appear at the bottom of the webpage. You will be

prompted:
Do you want to open or save Precedent.doc from westlaw.co.nz?
Click Open if you wish to open the file (and save it later from within MS Word).

Click Save to save the file first before opening.

Do you want to open or save Precedent.doc from westlaw.co.nz? Open Save > Cancel

x

By default, the file will save to the Downloads folder. If you click on the dropdown menu next to Save you

will have the option to Save as, to save the file to another location of your choice.

applications are closed. This will ensure the Precedents Dr To

Save as

Save and open
|

Open

After saving you will get a message:
The Precedent.doc download has completed.

You will be given the option to Open, Open folder or View downloads.
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Click Open to open the Precedent:

bl

The Precedent.doc download has completed. Open hd Open folder View downloads

When the Precedent opens, you may get a security warning asking if you wish to enable editing, for

example:

(| q‘:?, = Letter (1) (Protected View) - Word Imogen Wybourne =
Home Insert Design Layout References Mailings Review View Add-ins PDF Q Tellme
o PROTECTED VIEW Be careful—files fram the Internet can contain viruses, Unless you need to edit, it's safer to stay in Protected View. Enable Editing x
. . L'-g--‘|---1---|‘--2---|---3‘--|-‘-4--‘|---5---|--DG-‘
Navigation v
Search document P~

Headings Pages Results

If so, enable editing (to allow you to use the Precedent).

Continue to the instructions for Using the Drafting Aide

Return to top

Chrome

After you click on the Word icon, a link to the file Precedent.doc will display on the bottom left corner of

the webpage. By default, the file will download to the Downloads folder on your computer.

l eouson meurers

WESTLAW AU & Mytens B My Folders

#* WORKFLOW  TOOLS NEWSROOM

«» -
Document Options

FishPrc02 — Agreement for sale and purchase of

LI I )

1 to original

Documentin
ntex
Lontext [P UMMM .fingAide  Variable Information
You are in:
LT Precedent Type: Precedent @
_‘ Jurisdiction: New Zealand
- Last Reviewed: May 2015
¥ Fisheries
Precedents

FishPrc02 — Agreement for sale and purchase!
Notes on the precedent

Ly

purch

Notes to clauses

- Precedents

Clause 1.1

= [ Property rights —

FishPrc02 — Ay

mending and reg

i Copyright © 2017 Thomsan Reuters (Professional) Australia Limited ABN 64 DSE 914 658

1 M Pprecedentdoc

Oniid

Help Sites . Feedback Privacy Policy

A

Click on Precedent.doc to open the Precedent.
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When the Precedent opens, you may get a security warning asking if you wish to enable editing, for
example:

0 é?, E Letter (1) (Protected View) - Word Imogen Wybourne lal
Haome Insert Design Layout References Mailings Review View Add-ins PDF @
o PROTECTED VIEW Be careful—files from the Internet can contain viruses. Unless you need to edit, it's safer to stay in Protected View. Enable Editing x
) ) '-"g"‘""1""‘"2'"'"'3‘"""4"""'5"""a5"
Navigation v
Search document Lo~ )

Headings Pages Results

If so, enable editing (to allow you to use the Precedent
Continue to the instructions for Using the Drafting Aide

Return to top

Firefox

After you click on Word icon, a dialog box will appear: Opening Precedent.doc. Select Open with Microsoft

Office Word (default) and click OK to open the Precedent in MS Word (By default, the file will save to your
Downloads folder):

7 —
Opening Precedent.doc @

You hawve chosen to apen:
[ Precedent.doc

which is: Microsoft Office Word 97 - 2003 Document
fram: http:/favaannve stlawco.nz

What should Firefox do with this file?

() Dpenwith | Microsaft Office Word (default) -

@-Egaue File

[7] Do this gutornatically for files like this from now an,

| ok || Cancel

When the Precedent opens, you may get a security warning, asking if you wish to enable editing, for
example:

(| q‘:?, = Letter (1) (Protected View) - Word Imogen Wybourne =
Home Insert Design Layout References Mailings Review View Add-ins PDF Q Tellme
o PROTECTED VIEW Be careful—files fram the Internet can contain viruses, Unless you need to edit, it's safer to stay in Protected View, Enable Editing x
) ) I.'-g--‘|---1---|‘--2---|---J‘--|-‘-4--‘|---5---|--D6-‘
Navigation v
Search document Felnd )

Headings Pages Results
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If so, enable editing (to allow you to use the Precedent

Continue to the instructions for Using the Drafting Aide

Return to top

Checkpoint

To download a Precedent, click on the Word document icon:

next to the Tool Type:

4 TR INTERNAL IF

InsLol Shareholders special resolution appor ting licquicatar

- = s :
e
It v
| Product Tatle: Mrichvincy Pinid
B Docurment in Context Tool Typa: Forms and Tem
1 Last March 2014
Ravidwiad:

InsL01 — Shareholder's special resolution appointing
liquidator
[T-AALE OF COMPANT) LM ID

WRITTER [ RESOLUTION Ok RETOLUTIONT] OF THE THAREWOGLDERT OF THE COMPARY PURTUANT
TO SHCTION 122 OF THE COMPAMNIES ACT 1993

Dated: [3=dote]

fal resalusion

he chareholders resoh

To save and open the Precedent, follow the instructions for your browser, as for Westlaw NZ above:

Internet Explorer 11 Chrome Firefox
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CD-Rom

Simply click on Open the document in MS Word 97 or later beneath the Precedent title to open the document in MS
Word.

110 Folic Views - [Fisheries Precedents (Read-Oniy)] oo ==

(0 File Edit View Search ‘Window Help NEE
- [ report =] J = J @
=]

= [ FISHERIES PRECE « | N B
33 Lsermtormnation F|shPrcO2 — Agreement for sale and purchase of
I Proceents ;
= Prapen s Annual Catch Entitlement
o IshPrc01 -
% [ [FishPreoz - Open this docurnent in MsWord37 or later

% [ FishPrco3 -
% [ FishPrend -
&[] Permits — sarr Variable Information
@ [ Lefters

“p [ Statutory Forms name of vendor

nare of purchaser

day of month

rnanth, year

& = registered office/occupation and address of vendar J

G = registered officefoccupation and address of purchaser

7 = beginning and end date of fishing year

J 8= amount of price, in figures

9 = date of payment

10 = Account Mame, Bank, Account Number

11 = relevant percentage

12 = relevant percentage

13 = relevant percentage

Qption 1 (in or out) = vendor's signature

Choice 1A = vendor is individual

Choize 18 = vendor is company

Suboption 1 = signed by witness

Qption 2 (in or out) = purchaser's signature

Choice 24 = purchaser is individual

Choice 2B = purchaser is company

Suboption 2 = signed by witness

4 > Notes on the precedent

[ Hit Feference

@1 BB Scach J3 Biowse J[B) Document J& Conlenis J/= HilList 4 Obiect J

Record: 955/ 2,143 [Hit:0/0 [Quenys

L5}

1=
2=
3=
4=

11 {EN

Return to top

Using the Drafting Aide

For additional help with using the Drafting Aide, our Trainers are there to assist.
You may request help through the Training website:

http://training.thomsonreuters.co.nz/

The Training website also offers training resources such as videos, User Guides and webinars.

Launching the Drafting Aide

After opening a Precedent, launch the Drafting Aide by clicking on the Drafting Aide icon
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You will find the Drafting Aide icon in the Add-ins tab (MS Word 2007-2016) or in the Toolbar (MS Word 2003 and
below):

H -3 O |._.E - M5 Word 2016 images - Word e Wyboume

F||t

Hame | Insert | Design | Lopout L

bailings | Review | Vifw Farrmat

F3 Comvert to POF 3

Meny Commands Tookbar Commands Custom Toolbars

i ' 4

When you click on the Drafting Aide icon, the Drafting Aide will open, as below:

Wid9-0o0&=+

PRE17 [Compatibility Mode] - Microsoft Word
Home Insert

Page Layout References Mailings Review View Add-Ins

FOF
Convert to PDF &l

Menu Commands | Toolbar Commands| Custom Toolbars

L T e L
[} T

Precedents Drafting Aide w402 Type variable text *
Llx| 2] e|=lalale o

] 1=full name (type here) -

-

1

APPLICATION-FOR-WAIVER-OF-FEES—INDIVIDUALY]

Drafting Aide version

The first time you use the Drafting Aide, check the Drafting Aide is the latest version. The current version is v4.02:
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Variables

Variables are the bits of information that you fill-in in a form document (such as: [company name], [address],

etc); they are called “variables” because they vary each time you fill in the form.

The Drafting Aide will take you through all the variables in a Precedent and allow you to fill in each piece of
information one-by-one, without you having to type in the document itself; the Precedents Drafting Aide

automatically inserts whatever you have typed or selected into the correct place(s) in the form.

Where a variable occurs several times in a document — for example, [respondent’s name] — you only need to type
that variable once in the Drafting Aide and it will be copied automatically to all the other places in the document

where it appears.
Types of variables

The Thomson Reuters Precedents documents contain the following types of variables:

1. A request to fill in certain information, for example:
Precedents Drafting Aide vd.02  Type variable text oy
b ><|¢ - ||«£:|@|
3=occupation (type here) -
L
w
[3=0ccupation]
2. A choice variable, requiring you to choose which piece of text from a list you wish to insert, for example:
Precedents Drafting Aide w402 Select the appropriate item >
x| 2] +| -|a]2|e]
-
(O hearing
-

[6=filing OR hearing]
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A choice variable, requiring you to choose which piece of text from a list you wish to insert, part of the

choice being a request to insert further information, for example:

Precedents Drafting Aide w402 Select the appropriate item >

bl X

2| el -|a|ae

) {50=specify agreed improvements in poor condition fcross refer clause 7))

2. - IMPROVEMENTS:q

Improvements-in-poor'condition for'which the Tenantis not required-to-provide
deferred -maintenance:-[49=None.-OR--{50=specify-agreed-improvements-in-:
poor-condition-(cross-refer-clause-7)} |

An option whether or not to include a piece of text or a clause, for example:

Precedents Drafting Aide w402 Insert this text? Pt h
x| 2] 2 -] a] 2] 8]

F

L]

-

[2=full-name,-description-and-occupation-of-Tenant[y

“the'Tenant™q
</Option-1-(in-or-out)=guarantor|y
ANDY

[3=full-name,-description-and-occupation-of-Guarantor]y

“the'Guarantor”>9|
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A suboption (ie, an option that is within another option). For example:

Precedents Drafting Aide w402 Insert this text? >
xl2]e| -] a] 2]

Y

L]

-

[We-note-the- Agreement- is: |

~[Suboption 1 -(in-or-out)=agreement subject to-finance |

1. - Subjecttofinance |[[S=give details-of finance-conditions .~
~[Suboption 2-(in-or-out)=agreementsubject to-other-conditions ]
2. - Subjecttol/9=describe other-conditionsof agreement]. -9
~[Suboption 3-(in-or-out)=informing land-agent-of progress [

and-we-will-keep-you-informed- asto-progress-in-regard-to-satistaction- of {/ / =rhe-

condition-OR-condi tionsj ] H

A choice between two or more sections of the document (these sections can be just a phrase, or several

clauses in length), where you can only include one of the alternative selections, for example:

Precedents Drafting Aidevd.02  Select the appropriate item >

a

X2l el=lalalel

Q
@

JA=interest at the rate of a ceriain per cent per anvum <
I B=interest compounded on guarterly resis

4.

#t{Choice-14=interest-at-the-rate-of-a-certain-per-cent-per-annum/"|

domy 83

#/Choice-1 B=interest-compounded-on-quarterly-rests]q|

INTEREST-ON-PAYMENTS-IN-ARREARSY

4.1 - Ifthe Tenant-defaults-in-the-payment-of-the rent-or-other-moneys-payable-
pursuant-to-this-Lease for-/]6=number-of-working-days] -working-days-
then-the-Tenant-shall-pay-on-demand-interest-at-the rate-of-/ I 7=penalty-
interest-rate] -per-cent-per-annum-on-the-moneys-unpaid-from-the-due-
date for'payment-down-to-date-of-payment. #9|
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7. A subchoice (ie, a choice within another choice), for example:

a a= an il

Precedents Drafting Aide w402 Select the appropriate item *

c@‘

|22

0] [A=lack of capacity
) IB=person has capacity, cannot communicats n

+[Subchoice-1A=lack-of-capacity[q

(b) + The'specified-person-lacks, wholly-or-partly, the-capacity-to-
understand-the nature, and-to-foresee the-consequences, ot
decisions in‘respect-of matters-relating-to*/2/=his--OR--her] -
personal ‘care-and -welfare; +9

+[Subchoice-1B=person-has-capacity, -cannot-communicate] |

(b) + The'specified-person-has-the:capacity-to-understand-the:
nature,-and to-foresee the-consequences, -of decisionsin-
respect-of ‘matters relating:to*/2/=his--OR--her | ‘personal -care-

The variables appear in blue text in the documents.

Keyboard navigation in the Drafting Aide

e TAB: use the TAB key to navigate your way through the available options on the dialog box.

e ENTER: use the ENTER key to execute the selected button or to insert your typed text.

e  SPACE: use the SPACE key to execute the selected button.

. CTRL + ENTER: will create a new line when entering text.

e ARROW keys: use the ARROW keys to navigate between different choices in the variable information
box.

e SHORTCUT Keys: each button has it’s own shortcut keys — place your mouse over the button to see the

keys required or refer to the list below.

Please note: When using Word 2000 the text in the Precedents Drafting Aide may not be automatically
highlighted. To overcome this, simply press the TAB key and the text will be automatically highlighted.

Return to top

Mouse navigation in the Drafting Aide

SINGLE Click: using the left mouse button, a single click will execute the required button or place the cursor in the

input box.
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Drafting Aide Buttons

Press the Ctrl key and click on a button below to jump to the explanation for that button:

el ox 2] (e =l e

;_é

YES/OK: (ALT + Y)

The OK button will replace the highlighted variable with either your text or your selected option or choice.

>

Prqcedents Drafting Aidevd.02  Type vaniable text X

x| 2] x| =] 2] a]e]

1=full name (type here) .
>

NO/DELETE VARIABLE: (ALT + D)

The NO button will remove the highlighted text from the document. Including the preceding space if appropriate.

x
K

Prece}ﬂu Drafting Aide vd.02  Type vanable text

X

x| ¢l a|al o]
e —— -t
:
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SKIP: (ALT + K)

The SKIP button will skip the highlighted variable and then locate and highlight the next available variable.

:a'l\
PrecedentwDrafting Aide vd.02  Type variable text X
x| 2]e|=]a|ale) |
ull name (type here -
L]
L4
BACK: (ALT +J)
The BACK button will allow a user to modify a previously completed variable.
&
Precedents ing Aidevd.02  Type variable text Pt
b )(l# #l@l é'll@l |
-
-

LEAVE BLANK: (ALT + B)

The LEAVE BLANK button will replace the highlighted variable with one of the three available spaces: 2cm, 6cm
and 12cm.
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STOP: (ALT + S)

The STOP button will close the Precedents Drafting Aide.

Precedents Draftin vd02  Typevanable text

| x[e]e|=]a]a]e

Document reformat tools: (ALT + T):

Precedents Drafting Aide Type variable text

b )(l:'rl-:-ll.i

This button will present you with a pop-up box with several options. (This box will also pop up automatically when

there are no more variables to fill, or if you exit out of the Drafting Aide).

Precedents Drafting Aide v4.02 >

You have reached the end of the document.
Do you wish to:

[ Import styles from another document?

v Remove the editorial notes?
¥ Change all text to normal text?
[~ Renumber paragraphs?

[™ save the document?

e

The available options are:

1. Import styles from another document — this will allow user to import formatting styles from another

document.
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If Import styles from another document? Is selected, when you click the play button at the bottom of the
dialog box, you will be taken to the documents folder to select a document from which you would like

styles to be imported.

Browse to the document you would like to use, select that document and then click Open. The styles from

that document will then be imported into the Precedent (this may take a few moments).

! = Document? - Micresch Weed
Open ®
g ThaPC » CH(C] + Usens » imegen + Documents » Orafting Aide + letber . B B

&5 Bartoe s s Loy

File name: | Bactioe anc lensom Lavyert & Word Documents “
Tech = Comcel
y -[.'-éll'll {]y'E‘ﬂllﬂ"
Wellington¥
b
FAMI12345°ABv-YZ—49

Remove editorial notes — this will remove all instances of green italicised editorial notes and any

external logos or graphics present in the document.

Change all text to normal text — this will change the colour of the blue variable text to black and its

style to non-italic.

Renumber paragraphs — allows users to renumber paragraphs/subparagraphs automatically after

removing or adding paragraphs/subparagraphs.

The renumbering function can work with several different paragraph label formats (and combinations of

label formats — ie where several different label formats are used within one document):

. 1.,1.1,1.11..2., 2.1, 2.11...

@, @), (i)

(@), (0), (©

Any time you add paragraphs to or remove paragraphs from a Thomson Reuters Precedent, if you use the

Renumber Paragraphs? function, it will go through the document and renumber/resequence all the
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paragraph/subparagraph labels that are out of sequence (NB provided any added

paragraphs/subparagraphs have the same formatting/styling as other items in the same list).

You may use the renumbering function on a Thomson Reuters Precedent on its own, (for example, if you
filled in all the variables earlier, but later decide to add new paragraphs/subparagraphs or to remove

paragraphs/subparagraph - or both). Just:
e open the document;
. launch the Drafting Aide;
e click on the Reformatting Tools button;
. select the Renumber Paragraphs? option; and

. click the play button.

Cross-references: please note, the renumbering function does not currently resequence cross-
references (references within a document to other clauses or paragraphs in the same document) to match
renumbered paragraphs. If you use the renumbering function, any cross-references that are affected by

the renumbering will need to be updated manually.

Using the renumbering function on documents that are not Thomson Reuters Precedents:
Please note, the renumbering function may not necessarily work on documents other than Thomson
Reuters Precedents. For the renumbering function to work, paragraphs and subparagraphs must be
formatted/styled in a particular way. Thomson Reuters Precedents are pre-edited so all the paragraphs

and subparagraphs are already in the correct style to allow the renumbering function to work.

Save the document — this will allow you to save the document at the same time as exiting the Drafting
Aide.

HELP: (ALT + H)

This button will open the Help information.

L7

Precedents Drafting Aide v Type variable text X
b }(la- - Elj[_} 'E!| r
I=full name (type here) -
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TOGGLE SCROLL OPTIONS:

This feature will allow you to toggle between scrolling within the Drafting Aide box (the default) and scrolling
through the document (while the Precedents Drafting Aide continues to run).

Precedents Drafting Aide v4.02  Type

Clicking on the dot toggles between the two scroll options.

Moving the Drafting Aide Dialog Box

The Dialog Box may be moved from its current position on the screen by holding down the left mouse button on

the dialog box title bar, labelled Precedents Drafting Aide, and dragging the dialog box to a new position on the
screen.

Return to top

Document reformat tools

When all the variables in a Precedent have been filled; or, if the user exits out for the Drafting Aide, the Document
reformat tools dialog box will open automatically:

Precedents Drafting Aide v4.02 >

You have reached the end of the document.
Do you wish to;

[ Import styles from another document? |

v Remove the editorial notes?
v Change all text to normal text?
[ Renumber paragraphs?

[ save the document?

e
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These tools may also be accessed within the Drafting Aide by pressing the Document Reformat Button:

?_ial

The instructions for the Document Reformat Tools are outlined under Drafting Aide buttons, above.

Return to top
Tips/FAQs

1. What if I'm using the Drafting Aide and | find I don’t have all the information needed to fill

in a Precedent — can | run the Drafting Aide again later on the same document to enter the
rest of the information?

You may partially fill in a Precedent and then re-run the Drafting Aide on it to fill in more information

later, as many times as you need to.

If you run the Drafting Aide and skip over some variables, the next time you run the Drafting Aide it will
take you straight to those variables you did not fill in the last time (it will do this even if previously you

changed all the variables from blue to black text using the Document Reformatting Tools).

2. | already used the Drafting Aide to fill in all the variables in a Precedent — now I've
added/removed some paragraphs and | need to renumber the paragraphs again — can |
use the Drafting Aide just to renumber paragraphs?

If you run the Drafting Aide on a document where all the variables are already filled in, the Drafting Aide
will take you straight to the Document Reformatting Tools dialog box:

Precedents Drafting Aide w4.02 >

You have reached the end of the document.
Do you wish to:

[ Import styles from another document? |

v Remove the editorial notes?
v Change all text to normal text?
[ Renumber paragraphs?

[ save the document?
]

If you wish to renumber the paragraphs, just tick Renumber paragraphs? and click the play button (there

is no need to untick the two default options that are already ticked).

Return to top
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Using the Drafting Aide — Trouble-shooting

The Drafting Aide is not enabled (Word 2003, Word 2000 and Word 97)

Sometimes Word decides to disable the Precedents Drafting Aide. In Word, click Help, About, Disabled
Items. Disabled Items may list the Drafting Aide. You can enable the Precedents Drafting Aide by clicking

Enable.

Renumbering has not worked properly

If you use the renumbering function and renumbering does not work as you expected, there may be a

bug in the document. Please contact one of the Precedents Editors:

elani.rawson@thomsonreuters.com

imogen.wybourne@thomsonreuters.com

There seems to be an error in the Precedent

Please contact the Precedents Editors, (see the previous problem).

Any other problem

If there is anything else you need help with to do with using the Drafting Aide (or, if you need help with

any of the issues above) you may contact our Trainers through the Training website:

http://training.thomsonreuters.co.nz/

The Training website also offers training resources such as videos, User Guides and webinars.

Return to top
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